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Product Overview 
 
The ability to prepare operating financial reports on a cash basis is a common requirement found across a wide 
range of industries.  Whether needed for internal management or external reporting purposes, this need to report 
operations on a cash basis is typically satisfied by the utilization of non- integrated spreadsheets and 
reconciliation routines because traditional accounting systems tend to focus on accrual-basis reporting -- to the 
exclusion of cash-basis.  And in many instances, entities that must report primarily on a cash basis may by-pass 
the built- in features and functionality of traditional accrual systems (such as tracking and aging accounts 
payable and accounts receivable) to ensure their ability to quickly and properly generate cash-basis financial 
statements. 
 
This Cash Basis Reporting enhancement enables users of Microsoft Dynamics GP (GP) and Small Business 
Financials (SBF) to easily prepare cash-basis and accrual-basis financial reports by simply selecting the 
appropriate criteria at the time the reports are designed or generated.  Such functionality is accomplished by 
implementing a fully- integrated cash-basis reporting system to complement the built- in accrual-basis reporting 
provided by each of those products. 
 
Some of the basic functional features provided by Cash Basis Reporting are listed below. 
 
v The user is able to utilize Cash Basis Reporting regardless of the company’s specific 

account format structure.  For instance, whether a company utilizes a 1-segment, 4-digit account format or a 
6-segment, 50-digit account format (in the case of Microsoft Dynamics GP ), the setup process and functionality will 
be the same. 

 
v The tables and transactions created by this enhancement are independent of core 

accounting system data.  In other words, the user is able to remove this module and continue to utilize the 
core accrual-basis reporting functionality of SBF and Microsoft Dynamics GP. 

 
v Master records related to Cash Basis Reporting data are created automatically on an as-

needed basis.  Because many companies have general ledgers consisting of thousands of accounts, this 
enhancement does not require the creation of cash-basis accounts unless they are needed for transaction posting – 
and the creation of those accounts is transparent to the user. 

 
v Cash transactions originating in several Microsoft Dynamics GP and SBF modules are 

addressed by this enhancement, including:  
Ø Purchasing (including Payables Management, Purchase Order Processing and Project Accounting): 

manual payments, computer checks, immediate payments, voided checks, and manually-applied payments. 
Ø Sales (including Receivables Management, Invoicing, Sales Order Processing and Project Accounting): 

cash receipts, deposits, immediate payments, NSF transactions, voided payments, and manually-applied 
receipts. 

Ø Bank Reconciliation: bank transactions, bank transfers and bank reconciliation transactions. 
Ø U.S. Payroll: manual checks, computer checks and voided checks. 
Ø General Ledger: General Journal Transactions and Quick Journal entries. 

 
v Able to use all standard reporting tools of Microsoft Dynamics GP and Small Business 

Financials:  By using the standard reporting tools of the core Microsoft Dynamics GP  and SBF applications 
(FRx, SmartList, Advanced Financial Analysis, General Ledger Trial Balances, etc.) it is possible to prepare cash-
basis and accrual-basis financial reports simultaneously. 
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Technical Support 
 
AIM Technologies Technical Support is available Monday through Friday from 9:00 am to 5:00 pm 
Central time. 
 
Technical Support can be reached via any of the following methods: 
 

985-951-7580 (voice) 
253-295-0740 (fax) 

Support@AIM-Technologies.com 
http://www.AIM-Technologies.com/suprequest.htm 

 
 
Please include the following information with any support request: 
 
Ø Your company name and phone number. 
 
Ø Your name 

 
Ø The name of the product you are working with (Microsoft Dynamics GP or Small Business Financ ials) 

 
Ø The version of Cash Basis Reporting you are running (from the registration window). 

 
Ø A brief description of the problem. 
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Installation 
 

The installation of Cash Basis Reporting requires the following steps: 
 
1. Install Cash Basis Reporting Code 

 

v Unzip the CBR10b??.zip file that was downloaded from our web site, double click the 
Setup.exe file to run the setup routine. 
 

v The Cash Basis Reporting 10.0 - InstallShield Wizard window opens. 
Ø Click Next >. 
 

v Review the Software License Agreement, and confirm or deny your acceptance of the terms described 
within. 
Ø If desired, you can click the Print button to print a copy of the Software License 

Agreement for your records. 
Ø If you agree, select “I accept the terms of the license agreement” and click Next to 

continue. 
Ø If you disagree, select “I do not accept the terms of the license agreement” and click 

Cancel to exit the installation wizard. 
 

v Specify the folder where the Microsoft Dynamics GP / SBF application is installed. This folder is 
typically located on your local hard drive. 

Important: The installation routine will default the installation to a directory on the workstation.  If 
this is not the location where Microsoft Dynamics GP / SBF is installed on your machine, you will 
need to specify the correct directory. 

 
v Verify that it is the correct directory, or use the Change button to select the location of the desired 

version of Microsoft Dynamics GP / SBF. 
Ø After confirming the installation path, click Next >. 
 

v The Ready to Install window opens.   
Ø Click Install to copy all files to the appropriate directories.  
 

v The InstallShield Wizard Completed window opens when installation is done. 
Ø Click Finish. 
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2. Include the New Code  

After the Cash Basis Reporting files have been copied to your system, Microsoft Dynamics GP or SBF 
must then “include” the code. 
 
§ For Small Business Financials:  After launching SBF, the code will be included automatically. 

 
§ For Microsoft Dynamics GP:  After launching Microsoft Dynamics GP, you will see a prompt 

asking if you want to include new code, similar to the following illustration. 
  

 
 
  Click Yes and allow the code to be included. 
 

A progress bar will display, while the “unchunking” process is executing. 
 
This installation step performs the following tasks: 
 

Ø The DYNAMICS.SET file is modified to include the information required to run Cash Basis 
Reporting. 

 

Ø A dictionary named “CASH3122.DIC” is created in your Microsoft Dynamics GP / SBF application 
folder. 

 
Perform steps 1 and 2 from above on every workstation that is running Microsoft Dynamics GP / SBF. 
 
Installation of Cash Basis Reporting is now complete and you are ready to begin the Setup process. 
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Setup 
 
The procedures to setup and activate Cash Basis Reporting for your company are as follows: 
 
1. Login as System Administrator and Initialize System 

a) Login to the system as a system administrator (sa or DYNSA). 
b) Select the first company in which you want to setup Cash Basis Reporting. 
c) If the Cash Basis Reporting tables and procedures have not been created previously, you will receive the 

following prompt to initialize the Cash Basis Reporting system. 
 

 
 

d) Click Yes to initialize all Cash Basis Reporting tables and stored procedures and to grant access to those 
tables.  After completion, you will receive the following message. 

 

 
 

e) Click OK to close the message 
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2. Modify Account Format 

a) Open the Account Format Setup window (Tools > Setup > Company > Account Format). 
b) Increase the Account Length field by AT LEAST 1. 
c) Increase the Segments field by AT LEAST 1. 
d) Identify the Segment ID row that you want to use to identify cash-basis and accrual-basis transactions 

(typically, this will be the segment that was just added), and make the following changes: 
i) Edit the segment Name as desired (e.g. Cash/Accrual, etc.) 
ii) Edit the segment Length if needed 
iii)  Change the segment Display Width if desired 

e) The Account Format Setup window will appear similar to the illustration below, but will vary based on 
your individual system setup rules. 

 

 
 

f) Click the OK button to save your changes.  At that point you will receive a message dialog similar to the 
following: 

 

 
 
g) Click the OK button on the dialog box, click OK on the Account Format Setup window, and then run 

Check Links on the Account Master in the Financial series under File > Maintenance > Check Links. 
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3. Enter Cash Basis Registration and Setup Information 

a) Open the AIM Product Registration window (Microsoft Dynamics GP > Tools > Setup > Financial > 
CBR Registration).  

b) Enter the registered company name and keys as provided to you. 
c) Click OK to save the registration information and close the window. 
d) Open the Cash Basis Setup window (Microsoft Dynamics GP > Tools > Setup > Financial > CBR 

Setup).  The window should appear similar to the illustration below, but will vary based on your 
particular setup options selected. 

 

 
 

e) Populate the Cash Basis Setup options as follows: 
i) Cash/Accrual Segment : Select from the drop-down box the appropriate account segment to be used 

to identify cash-basis and accrual-basis transactions. 
ii) Cash Segment ID : Enter the character (alpha-numeric) to be used by the system to identify cash-

basis accounts. (This field is limited to the number of characters allowed in the Account Format 
Setup for this segment.) 

iii)  Accrual Segment ID : Enter the character (alpha-numeric) to be used by the system to identify 
accrual-basis accounts. (This field is limited to the number of characters allowed in the Account 
Format Setup for this segment.) 

iv) Unapplied Cash Disbursements : Enter the cash-basis account to be used to identify cash 
disbursement transactions that are not applied to invoices or other documents.  This account 
number MUST include the Cash Segment ID character created in step ii) above in its Cash/Accrual 
Segment.  Because this account has not yet been created, you will be prompted to add a new 
account.  Add the account following the normal Account Maintenance process. 

v) Unapplied Cash Receipts: Enter the cash-basis account to be used to identify cash receipt 
transactions that are not applied to invoices or other documents. This account number MUST 
include the Cash Segment ID character created in step ii) above in its Cash/Accrual Segment.  
Because this account has not yet been created, you will be prompted to add a new account.  Add 
the account following the normal Account Maintenance process. 

vi) Default all new journal entries to be mirrored in the cash basis ledger:  When posting journal 
entries via the Transaction Entry function of the general ledger, the user has the ability to mirror 
the accrual-basis entry being posted – automatically – in the cash-basis ledger by simply selecting 
the option in the Cash Basis JE window.  Checking or unchecking this option in the Cash Basis 
Setup window will change the default setting for subsequent general journal transactions. 

vii) Enable Cash Basis Reporting : Checking this box will activate the Cash Basis Reporting 
functionality for future transactions.  Likewise, unchecking this box will disable Cash Basis 
Reporting functionality for future transactions. 
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viii)  Update Accrual Segment:  The Update Accrual Accounts routine will automatically edit all 

existing general ledger accounts that have a BLANK Cash/Accrual Segment, to reflect the defined 
Accrual Segment ID in the Cash/Accrual Segment.  This utility MUST be run at least once to 
ensure the ability to prepare accrual basis reports after the Cash Basis Reporting functionality has 
been enabled.  

ix) Create Cash Basis Accounts :  By design, the Cash Basis Reporting module will create 
corresponding cash-basis ledger accounts that do not exist during normal cash-basis transaction 
processes (such as PM checks, RM receipts, etc.)  However, if preferred, you can create the 
corresponding cash-basis ledger accounts that correspond to ALL accrual-basis ledger accounts by 
executing the Create Cash Basis Accounts routine as part of the setup process.  If you do wish to 
run the Create Cash Basis Accounts routine, the Update Accrual Segment routine MUST be run 
PRIOR to the Create Cash Basis Accounts routine. 

x) Save Changes:  Click the OK button to save your changes and close the window.   
 
4. Initialize and Setup Additional Companies 

a) While logged into the system as a system administrator (sa or DYNSA), log into each additional 
company that is setup in your system. 

b) Repeat step 1 above for EVERY company.  This step MUST be done for every company to initialize the 
Cash Basis Reporting tables and procedures, regardless of whether Cash Basis Reporting will be 
activated for the company. 

c) Repeat steps 2 and 3 above for each company in which you want to activate and utilize Cash Basis 
Reporting. 
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Transaction Processing 
 

Once Cash Basis Reporting is registered and enabled in the Cash Basis Setup window, all cash-basis transaction 
processing is handled automatically by the Cash Basis Reporting code – completely transparent to the user.  
Below is a summary of the processes that occur to create the cash-basis general ledger. 
 
For all cash transactions (payables computer checks, payables manual checks, cash receipt transactions, 
payment transactions entered with payables or receivables invoice transactions, payment voids, bank 
transactions, payroll checks, etc.), the Cash Basis Reporting system AUTOMATICALLY creates a series of 
entries to cash-basis general ledger accounts, IN ADDITION to the NORMAL accrual-basis distributions 
created by SBF / Microsoft Dynamics GP.  The specific cash-basis accounts that are debited or credited will 
vary based on different situations as outlined below. 
 
Also, the Cash Basis Reporting system will AUTOMATICALLY create corresponding cash-basis general 
ledger accounts needed at the time of transaction processing, IF those accounts did not previously exist.  See the 
Cash/Accrual Account Link Editing section below for more information on the ability to edit these 
automatically created account relationships. 
 
1. Payables Transactions 
 

a) Unapplied Cash Disbursements : A payables cash disbursement (or any portion of a disbursement) that 
is NOT APPLIED to an invoice (or other payables document) in the system when posted will create a 
debit to the Unapplied Cash Disbursements account, as defined in the Cash Basis Setup window. 

b) Fully Applied Cash Disbursements: A payables cash disbursement that is applied in full to an invoice 
or other available document in the system will create the appropriate debits and credits to cash-basis 
accounts that correspond to the accrual-basis accounts to which the originating invoice or other 
document had been distributed.  For example, if a $100 payment is applied to a $100 invoice that had 
originally been distributed and posted to account 000-6540-00-A (Office Supplies Expense), the Cash 
Basis Reporting system will accordingly create a $100 debit to 000-6540-00-C at the time of the check 
posting to record the cash-basis expense related to this transaction. (The same logic holds for multiple 
distributions on one invoice or across multiple invoices.) 

c) Partially Applied Cash Disbursements: A payables cash disbursement that is applied to an invoice or 
other document on which the remaining amount to be applied is GREATER than the amount of the cash 
disbursement will create the appropriate debits and credits to cash-basis accounts that correspond to the 
accrual-basis accounts to which the originating invoice or other document had been distributed, in 
amounts equal to the ratio of the payment as it relates to the document applied to.  For example, if a 
$100 payment is applied to a $500 invoice that had originally been distributed and posted to account 
000-6540-00-A (Office Supplies Expense), the Cash Basis Reporting system will accordingly create a 
$100 debit to 000-6540-00-C at the time of the check posting to record the cash-basis expense related to 
this transaction.  (The same logic holds for multiple distributions on one invoice or across multiple 
invoices.) 

d) Subsequent Apply To Transactions : The subsequent application of a previously-posted payment 
transaction to a previously-posted invoice or other document will create the corresponding cash-basis 
transactions, as of the Apply Posting Date, following the same logic as in scenarios b. and c. above. 

e) Voided Payments : The voiding of a payment transaction will create the appropriate reversal of the 
cash-basis transactions that had been created by the original payment entry, as of the Posting Date 
indicated for the void transaction.  
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2. Receivables Transactions 
 

a) Unapplied Cash Receipts: A receivables cash receipt (or any portion of a disbursement) that is NOT 
APPLIED to an invoice (or other receivables document) in the system when posted will create a credit 
to the Unapplied Cash Receipts account, as defined in the Cash Basis Setup window. 

b) Fully Applied Cash Receipts : A receivables cash receipt that is applied in full to an invoice or other 
available document in the system will create the appropriate credits and debits to cash-basis accounts 
that correspond to the accrual-basis accounts to which the originating invoice or other document had 
been distributed.  For example, if a $100 payment is applied to a $100 invoice that had originally been 
distributed and posted to account 000-4540-00-A (Other Sales Revenue), the Cash Basis Reporting 
system will accordingly create a $100 credit to 000-4540-00-C at the time of the payment posting to 
record the cash-basis revenue related to this transaction. (The same logic holds for multiple distributions 
on one invoice or across multiple invoices.) 

c) Partially Applied Cash Receipts : A receivables cash receipt that is applied to an invoice or other 
document on which the remaining amount to be applied is GREATER than the amount of the cash 
receipt will create the appropriate credits and debits to cash-basis accounts that correspond to the 
accrual-basis accounts to which the originating invoice or other document had been distributed, in 
amounts equal to the ratio of the receipt as it relates to the document applied to.  For example, if a $100 
receipt is applied to a $500 invoice that had originally been distributed and posted to account 000-4540-
00-A (Other Sales Revenue), the Cash Basis Reporting system will accordingly create a $100 credit to 
000-4540-00-C at the time of the check posting to record the cash-basis revenue related to this 
transaction.  (The same logic holds for multiple distributions on one invoice or across multiple invoices.) 

d) Subsequent Apply To Transactions : The subsequent application of a previously-posted cash receipt 
transaction to a previously-posted invoice or other document will create the corresponding cash-basis 
transactions, as of the Apply Posting Date, following the same logic as in scenarios b. and c. above. 

e) Voided Receipts / NSF: The voiding of a cash receipt transaction will create the appropriate reversal of 
the cash-basis transactions that had been created by the original cash receipt entry, as of the Posting Date 
indicated for the void transaction.  

 
3. Bank Transactions / Bank Transfers / Bank Reconciliation Transactions 
 

a) Bank Transactions : All Bank Transactions, Bank Transfers and Bank Reconciliation Transactions are, 
by definition, cash-basis transactions.  Accordingly, the Cash Basis Reporting system will automatically 
create the appropriate debits and credits to the cash-basis accounts that correspond to the accrual-basis 
accounts to which the originating bank transactions are distributed. 

b) Voided Bank Transactions :  All voids of Bank Transactions will create the appropriate reversal of the 
cash-basis transactions that had been created by the original Bank Transaction entry.  

 
4. Payroll Transactions 
 

a) Required Payroll Posting Setup Rules:  The standard payroll posting routines of Microsoft Dynamics 
GP and SBF require users of Cash Basis Reporting and Payroll to confirm that the payroll posting rules 
setup in the Payroll Posting Accounts Setup of Microsoft Dynamics GP adhere to the following rules.  If 
these account posting rules are not followed, the cash basis reports will not be accurate. 

a. For the Payroll Account Type of Federal Tax Withholding (CR), the account(s) specified for the 
employer FICA tax liabilities (EFICA/M and EFICA/S) must be different than the account(s) 
specified for the employee FICA withholdings (FICA/M and FICA/S). 

b. For the Payroll Account Type of Federal Tax Withholding (CR), the account(s) specified for the 
employer FICA tax liabilities (EFICA/M and EFICA/S) must be different than the account 
specified for the employee Federal withholdings (FED). 
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b) Payroll Checks: Whether computer checks or manual checks, all Payroll Check Transactions are by 
definition in the SBF / Microsoft Dynamics GP system, cash-basis transactions.  Accordingly, the Cash 
Basis Reporting system will automatically create the debits and credits to the appropriate cash-basis 
accounts that correspond to the accrual-basis accounts to which the originating Payroll Check 
Transactions are distributed. 

c) Voided Payroll Checks:  All voids of Payroll Checks will create the appropriate reversal of the cash-
basis transactions that had been created by the original Payroll Check Transaction entry.  

 
5. General Journal Transaction Entry and Quick Journal Entry 
 

a) Cash-Basis Controls : Similar to other control accounts in the Microsoft Dynamics GP and SBF system 
(cash, accounts payable, accounts receivable, etc.), general journal entries to cash-basis ledger accounts 
should be needed only in the case of corrections or adjustments.  As a result, cash-basis ledger accounts 
that are automatically created by the Cash Basis Reporting module are created with the “Allow Account 
Entry” option disabled (unchecked) in the Account Maintenance window.   

b) Adjustments to Accrual-Basis Accounts AND related Cash-Basis Accounts :  After opening the 
general ledger Transaction Entry or the Quick Journal Entry window of Microsoft Dynamics GP or SBF, 
an additional Cash Basis JE window opens automatically.  
 

 
 

This window includes the option to “Mirror this Journal Entry in the Cash Basis journal.”  By selecting 
(checking) this option, any entries to accrual-basis accounts in the Transaction Entry window will 
AUTOMATICALLY create “mirrored” transaction entries in the appropriate cash-basis accounts when 
the journal entry is posted.  Furthermore, direct entries to cash-basis accounts will NOT be permitted 
with this option selected.  The default selection for this option can be set in the Cash Basis Setup 
window, as described in Setup section above. 
 

c) Adjustments to Cash-Basis Accounts ONLY: Direct entries to cash-basis general ledger accounts 
ARE permitted in the general ledger Transaction Entry and the Quick Journal Entry windows.  
However, because the cash-basis ledger accounts are automatically created with the “Allow Account 
Entry” option disabled (unchecked) in the Account Maintenance window, the user will need to enable 
(check) the “Allow Account Entry” option in the Account Maintenance window for the appropriate 
cash-basis accounts before proceeding.  After posting the cash-basis account journal entry, it is 
HIGHLY RECOMMENDED that the “Allow Account Entry” option be reset to disabled (unchecked) to 
prevent unintentional postings to these accounts.  Also, entries to cash-basis accounts are NOT allowed 
if the option to “Mirror this Journal Entry in the Cash Basis journal.” has been selected. 
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Cash Basis Account Link Editing 
 
To further facilitate the user’s ability to have the Cash Basis Reporting system create corresponding cash-basis 
ledger entries in accordance with specific operational or procedural preferences, the Cash Basis Account Links 
window is available (Microsoft Dynamics GP > Tools > Setup > Financial > CBR Account Links). 
 
The Cash Basis Account Links window allows the user to manually override the accrual-basis / cash-basis 
account relationships that are automatically created by the Cash Basis Reporting system. 
 
For example, if a cash disbursement is processed and applied to a payables invoice that was originally 
distributed to the accrual-basis Prepaid Insurance asset account, the Cash Basis Reporting system will 
AUTOMATICALLY create a corresponding cash-basis Prepaid Insurance asset account.  However, if the user 
would prefer that payment of invoices originally coded to this asset account ACTUALLY be recorded to a cash-
basis expense account (e.g. Insurance Expense), this Cash/Accrual Account Link window provides the 
flexibility to modify such accrual-basis/cash-basis account relationships.  The illustration below provides an 
example of what the Cash Basis Account Links window might look like. 
 
 

 
 
 
Furthermore, if the user would like to manually create certain accrual-basis/cash-basis account relationships, 
simply scroll to the bottom of the Cash Basis Account Links window and either key in or lookup the accrual-
basis account for which you want to create the cash-basis account, then tab off of the Accrual Account Number 
field and the related cash-basis account will be created for you. 
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Financial Reporting 
 
As a result of the configuration and transaction processes described in the sections above, the preparation of 
cash-basis and/or accrual-basis reports can be achieved by simply limiting the particular report to the 
appropriate segment restrictions, using the normal reporting tools provided by Microsoft Dynamics GP and 
SBF. 
 
For example, to run a cash-basis General Ledger Trial Balance or Financial Statement, insert a restriction in the 
report design window to include ONLY accounts that contain the Cash Segment ID (e.g. “C”) in the 
Cash/Accrual segment.  Likewise, to generate an accrual-basis Trial Balance or Financial Statement, insert a 
restriction in the report design window to include ONLY accounts that contain the Accrual Segment ID (e.g. 
“A”) in the Cash/Accrual segment.   
 
Furthermore, all other segment, date, account and other criteria remain available for selection to create reports 
by particular departments, divisions, etc., from the cash-basis or accrual-basis ledger accounts.  The illustration 
below represents an example of how a cash-basis Profit & Loss statement could be generated. 
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Year-End Closing 
 
To enable true on-going cash-basis financial reporting, Cash Basis Reporting modifies the general ledger Year-
End Closing procedure.   However, the modified Year-End Closing process is transparent to the end user. 
 
Cash Basis Reporting will close out all cash-basis Profit & Loss accounts to the cash-basis Retained Earnings 
account that corresponds to the accrual-basis Retained Earnings account that is setup for the particular 
company, in addition to the “normal” close of the accrual-basis Profit & Loss accounts and the balance forward 
transaction entries for all balance sheet accounts.  This process ensures that the cash-basis and accrual-basis 
ledgers remain in balance from year to year. 
 
 
 
 


